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An Introduction to Shri Jyoti Star 6 
 
 
Thank you for your order for Shri Jyoti Star. I hope you have great success and fun with it. See below for 
the terms of sale of the licence. Installation: Put the CD in your drive and it should start. If not, click 
Start and Run Setup.exe. Vista: Install using the user account that will be using the software. Turn to the 
next page for how to get started. 
 
 

IMPORTANT NOTICES 
 
If you need help, email me at support@vedicsoftware.com or call 1-434-973-2779. Enjoy! 
 

Legal Stuff 
 
Thank you for choosing Shri Jyoti Star, a Shri Jyoti software product. Due to the disputative nature of our world it is 
unfortunately necessary to draw your attention to the following warranty disclaimer and license agreement. Using Shri Jyoti 
software means you agree to be bound by these. 
 
DISCLAIMER - AGREEMENT 

Users of Shri Jyoti Star v6 and all other versions of Shri (Sri) Jyoti software and upgrades must accept this disclaimer of 
warranty: SHRI JYOTI SOFTWARE AND ANY UPGRADES SUPPLIED ARE SUPPLIED AS IS. THE AUTHOR 
DISCLAIMS ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE 
WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR ANY PURPOSE. THE AUTHOR ASSUMES NO 
LIABILITY FOR DAMAGES, DIRECT OR CONSEQUENTIAL, WHICH MAY RESULT FROM THE USE OR NON-
AVAILABILITY FOR USE OF SHRI JYOTI STAR V6 AND ANY OTHER VERSIONS AND UPGRADES SUPPLIED 
AND ANY ADDITIONAL PRODUCTS SUPPLIED. 

LICENSE AGREEMENT 

This SOFTWARE PRODUCT (the Shri Jyoti software/Sri Jyoti software) is proprietary to Andrew Foss (the author) and is 
protected under US and international copyright law. This Single User License entitles you to use the SOFTWARE PRODUCT 
on the following terms: 

The SOFTWARE PRODUCT is for your exclusive use. You can make copies of the SOFTWARE PRODUCT for archival or 
backup purposes but you must ensure that no other person uses the SOFTWARE PRODUCT. Within thirty (30) days of 
purchase you may return the disk(s) for replacement if any physical defects occur (including, for example, damaged or 
incorrect disks). The author and his agents provide no other warranty, and under no circumstances will the author's or his 
agents' liability to you exceed the retail price of the SOFTWARE PRODUCT. 

You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such 
activity is expressly permitted by applicable law notwithstanding this limitation. 

You may not sell, rent, lease or lend the SOFTWARE PRODUCT except insofar as you may permanently transfer all of your 
rights under this licence to another person with the permission of ShriSource Inc. The original product and its upgrades are 
used under a single licence and may not be transferred separately. 

By using the SOFTWARE PRODUCT/Shri Jyoti software product(s) covered by this license, you agree to become bound by 
its terms. This agreement will be governed by Virginia law. 

The SOFTWARE PRODUCT remains the property of the author. Licences of this product and its upgrades, related products, 
and the registration codes for them are granted entirely at the discretion of the author. The license and your right to use the Shri 
Jyoti Star software automatically terminates if you fail to comply with any provisions of this agreement.  

If you have any questions about this agreement please feel free to contact the author in writing at the following address.  A 
Foss, PO Box 91, Earlysville, VA 22936, USA. 
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Getting Started 

 
Welcome to the world of Vedic astrology software. Shri Jyoti Star will empower you to learn and explore 
Vedic astrology with ease and power. Its built-in atlas will automatically look up the coordinates and time 
zones for over 250,000 cities, and you can calculate accurate charts over thousands of years. 
 

An Introduction to Windows Programs 
(with hints for using Shri Jyoti Star) 

 
Windows programs typically follow certain conventions: 
 
1. Several methods of getting to the same result. Windows was designed to make it easier to use 
software. You can move the pointer using your mouse and then left click on an item to choose it, or use 
pull-down menus, or hotkeys, or right-click the mouse and choose from the menu that pops up. 
 
A. Pull-down menus.  
 

Most Windows programs have a list of menu options in a row at the top of each page. For example, in 
the Data Entry Window shown on page one, the pull-down menu options shown are:     

File   Data  Tags   Confirm   Entry Choices   Help 
 
Note the underlined letters in each of the categories. They indicate that if you hold down the Alt key 

and press the underlined letter, that menu will drop open. E.g. holding Alt down and pressing the F key 
will open the File menu. (In Windows XP you may have to hold down the Alt key before you see these). 
 
B. Hotkeys 
 

When you open the File menu of the Data Entry Window, you will also see "hotkeys" shown next to 
some of menu choices. For example, after the words Save As is the hotkey Ctrl+A. This means that if 
you hold down the Control key and then tap the letter A, then you will get the same result as if you 
highlighted the Save As item and hit the Enter key (or just mouse-clicked on that item). 

 
In other words, in all parts of Shri Jyoti Star, there are hotkeys that enable you to achieve the same 

results as using the menus to make choices, but more quickly. 
 
Here are some Important Hotkeys in Shri Jyoti Star: 
 
A. Undo. If you change something and want to change it back to the way it was a moment ago, hold 
down the Control key and press the letter Z. This Ctrl+Z hotkey works throughout Shri Jyoti Star, i.e. in 
the Data Entry Window, the Main Window, and on the Printed Page Designer Window. 
 
B. Save Options and Layouts. If you design your own screen in the Main Window, or a page in the 
Printed Page Designer Window, you may want to save the changes that you've made right away. In both 
windows, pressing Ctrl+O will immediately save and preserve the changes you have made. (That is, hold 
down the Control key and press the letter O.) Otherwise, the layouts and option changes will be saved 
when you leave the program unless you turn this off (Data Entry Confirm menu). 
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C. Open a new "Primary Native" or "Native 2". Shri Jyoti Star is unique in allowing many different 
people's charts and tables to be shown onscreen at the same time, with the first person's charts and tables 
having a red heading and the second person's charts and tables having a blue heading and the others have 
a green heading. You therefore need a way to open each new person's chart quickly and easily. To open or 
change the "Primary Native", i.e. the chart of the first person, you simply press Ctrl+A. To open or 
change "Native 2", i.e. the chart of the second person, you press Ctrl+B or click Ctrl+L and select from 
the list. 
 
D. Move to different Pages. When you are looking at the Main Window or the Printed Page Designer 
Window, you can use the Page Up and Page Down keys (PgUp, PgDn)  to move to different screens. 
Important notes: if you move to a blank screen, it just means that you haven't added anything to that 
screen yet. Also, in the Printed Page Designer Window, pressing Page Down and Page Up only shows 
you the screens within one design. I'm saying this because in the Printed Page Designer, you can create 
many different designs, by clicking on the New Design button and giving the design a new name and then 
adding charts, graphs, and tables to the design. 
 
E. Escape. Sometimes additional screens appear on top of the Main Window or Printed Page Designer 
Window. (E.g. the AstroMap, Choices and Options, and Search for Combinations screens.) You can 
escape back to the Main Window by simply pressing the Esc key that is at the top left of your keyboard. 
 
2. The Right-Click Mouse Options. The right mouse button (the one you usually don't use) has many 
important functions in Shri Jyoti Star. In the Data Entry, the Main Screen and the Printed Page Designer 
Window, right-clicking on a page or specific chart pops up a menu with many important shortcuts. You 
can print pages, change pages, select a native, swap natives, choose colour schemes, copy a chart or even 
email a chart, and almost everything else you might want to do. 
 
You can use the swap feature if you want to create a table or chart for the second person instead of the 
first person. 
 
Note:  Right-clicking on any chart, table or graph and selecting ‘What’s This?’ gives you handy 
information about it. Learn more about Jyotish and Shri Jyoti Star by browsing the tables, charts and 
graphs and using this feature. 
 
The ABCs of Using Shri Jyoti Star. 
 
1. Steps to take the first time you run Shri Jyoti Star: 
 

A. Run Shri Jyoti Star and email the code in order to be sent your password, and then when you get 
the return email, enter the password to get the program registered. 
 
B. After you enter the code, Shri Jyoti Star will step you through creating a new database. In future 
you can do this by clicking File and selecting New Database. The name of your current database 
appears at the top of the Data Entry screen. 

 
2. Enter a person's birth data in the Data Entry Screen (see #1 in the next section). The program 
automatically looks up the coordinates and time zone for the birth place, so all you have to do is click on 
the OK button to proceed (or click OK + Transit to also calculate the current transit chart as ‘Native 2’, 
the secondary chart. The first time you click OK this will happen automatically). When the program asks 

4 

 



An Introduction to Shri Jyoti Star 6 

you, if you want to save the person to the database (chart file), press the OK button. 
 
3. You are now in the Main Screeen (see #2 in the next section). Here is where you interact with the 
program, viewing all of the charts, tables, graphs, and dasha listing for the chart you entered. You can use 
the pages already designed for you (see Layout Examples below) or design your own pages by clicking 
on empty areas of the screen and selecting what you want from the Choices and Options 
screen that pops up. 
 
4. When you want to design your own pages to print out, or again use pre-designed layouts, click on the 
Printed Page Designer button. (see #3 below for more information). 
 
Important Note on Getting Updates:  
 

Shri Jyoti Star is being continually improved. You should definitely check the website often (every 
other month or so) for updates, as they have significant enhancements.  

 
To do so, go to www.vedicsoftware.com and scroll down to the Customer Area - Registration and 

Upgrades and click on that link. Know your version number, it is on the startup screen like ‘v6.1’ and also 
under ‘About’ at the bottom of the Help menus. It will say if there is an update for your version. 
 
Shri Jyoti Star 6 has three main screens: 
 
1. The Data Entry Screen. This is the first screen you will see when you run the program.  
 

The Data Entry screen has several functions: 
 
A. Creating new charts. To create an entry for a new person, simply enter the person's name, the date of 
birth, time of birth, place of birth and gender, and then click on the OK button. Note: however you enter 
names, they can be seen First Name Last Name or Last Name, First Name using the File menu item ‘Last, 
First Name in Lists’. When you click OK, the program will ask you if you want to save the chart, and then 
you will see their chart on the Main Screen of the program. (Note: if you want the program to compute the 
person's chart and also a second chart for the present moment, press the OK (+Transit) button instead of 
the OK button. If you just want a chart for the present moment, click the Now Chart button on the top 
right.) 
 
B. Retrieving saved charts from the database. The term "database" simply means a collection of saved 
charts. To retrieve the chart of someone who you have previously entered into the program, type in the 
first few letters of the person's last name (or first if you use First Last), and then hit the down arrow key 
until the right name appears. Then hit the Enter key. You can also use the Search features. There is a 
button at the top or put part of the name into the Search area under the Lists box and click the Search 
button. 
 
C. Adding notes to any chart. Click the notes button at the top of Data Entry or select 'Edit/View or Edit 
Notes for Primary' in the main screen. You can add up to about 8 pages of notes. 
 
D. In the Data Entry Window you can also import charts from other programs, see a monthly calendar, 
add events to a person's chart, view only those charts with planets in specific signs, and more. 
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Use the File menu to change from First Last to Last, First name style and also between USA or 
International date styles. In the US, the month comes first (MDY) while elsewhere the day comes first 
(DMY). Use the Entry Choices menu to minimize key strokes with two digit year entry and two different 
styles for entering dates and times, Each has its merit, try them. Above you see the ‘Free Form’ style 
where you can also type ‘June 21’ as well as 6/21. Whatever you type it is converted to numbers. The 
time above could have been entered as ‘9 3p’ and the focus would immediately jump to the City field 
saving you key strokes. The File menu has many other features such as help with backing up and 
transferring files. We recommend using a flash drive but a CD, floppy or any other storage device will 
work. Charts are stored in a file called a database and you can create new ones, open an existing one or 
change the name under File. Database files are much like document files you create in MS Word or other 
word processors. Use the Search features to find charts in large databases. Use the Lists pull down 
(middle top) and the shortcut buttons to the right of it to filter your charts to make finding things easy. 
Use the Tags menu to create groupings. For example, tag all your family ‘A’. Then you can easily see just 
their charts when you want. (Tip: click the [A] button on the top right.) 

 
Tip: Pressing F8 on your keyboard (also under the Data menu) when the screen first appears to restore 

the setup you were last using with all the charts loaded – available for use from the <>Native menu and 
the Right-click menu in the Main Screen. This is so useful, try it. 

 
Transits: It is very useful to see the chart for your current time and location. The program knows the 

time and date but you have to tell it where you are. Do this by clicking the New Location button on the 
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top right. You can have many locations. See the list by clicking Show Locations. Clicking Now Chart 
gets you the transit chart for the last used location.  The first time you click OK you get the default transit 
chart calculated for you and after that all you have to do is click OK+Transit. The Main Screen has a 
real-time clock option (under the Special menu) if you want the time to keep updating. 
 
2. The Main Screen 
 

This is the window you will use to work with charts onscreen. You can design up to 24 different 
screen pages and load screens pre-designed for you by selecting them from the Layout Examples menu. 

 
Here’s the Data and Button Bar at the top of the screen with explanations. It makes it really easy to 

access the key features. Note: if your screen has a lower resolution, you may not see all the buttons. Use 
‘Same as Buttons’ in the right-click popup; everything is also available from the menus at the top. 

 

 
Important things to understand on the Main Screen: 

 
A. Whose chart are you looking at. At the top of the screen under the grey menu bar on the far left is the 
name of the person whose chart is open, shown in red. A little to the right of this is another name (or 
Now) in blue. That is the name of the second chart that is open. The one in <> brackets changes when you 
use the time change tools or the <>Native menu. 
 
B. The page number. To see which of the 24 screens you are viewing, look between the [<Pg] and [Pg>] 
buttons at the top middle of the screen. The number between them is the page you are viewing. 
 
C. The speed buttons. Across the top are handy short-cuts to many functions. In the main Screen, pause 
the mouse over any of these to get a hint about there usage. Key buttons include ‘Print’, ‘Design’ – go to 
the printed page designer area – and ‘Pg’ – the Page Wizard.  
 
D. The menu items. In the grey bar at the top of the screen are several menus, e.g. File Edit Pages, etc. 
Here is a brief description of some of the functions of each of the menus: 
 

i. File. Here you can open a new chart, save the changes to the screens that you've made, restore the 
program's settings to their original status (with the Reset Options, but please use this only if you really 
want to lose all of the changes you've made to the program settings), exit the program, and much more. 

 
ii. Edit. You will primarily use this to edit someone's birth data or swap between the two charts. You 

will primarily use this to edit someone's birth data or to open a new chart butit also has Undo and Copy 
functions. Undo steps back the last drag and drop or resize and then it reverts to the version of the page 
when you entered or saved it. Copy puts the screen in the clipboard so you can paste it into an email or 
article you're writing. You can copy individual charts from the right-click menu. 
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iii. Pages. This menu lets you quickly go to any page, and to also blank a screen (clear all the charts 

and tables from it – use carefully), copy one page to another, and name a page that you've created (which 
will make it easier to find). 

 
iv. Format. Here you can select the number of places there will be for charts, tables, graphs, dasha 

listings, etc. Each individual page of the Main Window can have its own format such as 4x3 ‘cell’ per 
page. In addition to the choices here, you can use the pageWizard to choose anything you like up to 
10x10. The font size of tables depends on the cell size so don’t have too many! Charts and graphs can be 
resized by draggin so they can be any size but tables are tied to the cells giving uniformity to the result. 

 
v. Layout Examples. This menu allows you to choose from all of the pre-designed pages the 

program offers. When you make a selection you will be asked to choose between replacing the current 
layout or putting it on a new page. Choose the first only if you are ready to lose the layout you have 
already created. Ctrl+Z recovers to what you just had if you make a mistake. You can choose not to be 
asked using the Confirm menu in Data Entry. 
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vi. Special. This has many different functions. The Karakas are a list of themes signified by specific 
planets or houses. You can type in a topic, and the program will find the signifying planet or house. 
'Classical Yogas and Time Search' helps you to find when a particular planet or planets were in specific 
signs or degree positions, as well as what charts in the database have specific classical yogas. 'Custom 
Yogas Create and Search' is a very powerful tool letting you specify combinations (Custom Search) and 
search for them in your databases. You can also use it to create reports, it is a complete Report Builder 
(see the Help section for more details on this feature.) The Special menu has other, less important 
functions, that you can also learn about in the Help section. 

 
vii. Reports. Here's where you can view and print out interpretive reports for a person's chart. Click 

on 'Choices' and then on Select All, and OK to see all of the classical interpretations. 'Custom Reports' 
runs reports created in the Report Builder (see last section) by yourself or anyone. The two other most 
important sections of Reports are the Panchang/Transits and the Ephemeris and Rising times. Use the 
Ephemeris and Rising times to view and print tables of planetary positions and rising signs. The Panchang 
feature is more powerful, and allows you to view and print listings of transits to the birth chart, planetary 
entries into signs and Nakshatras, details about the Moon's placement, and much more. Please study the 
Help section on this feature to learn more. 

 
viii. Time/Space Change. For those who want to see what happens if a person's birth time is shifted 

forward or backwards in time, this is a wonderful tool. You must first click on the first menu choice: 
Setup Primary Native..., (or click on the person’s name at the top left) and then click on the third menu 
choice (Time Change Dialog) to select the time increment you want the chart shifted by (e.g. one minute 
at a time) or click on the increment which is shown to the right of the [<Pg][Pg>] buttons at the top. Then 
click on the [<<] button at the top of the screen to shift the birth time backwards by one time increment 
per click and click on the [>>] button to shift the birth time forwards by one time increment per click. E.g. 
if I had selected a one minute increment, and wanted to move the chart 3 minutes earlier, I'd click on the 
[<<] key three times. You can get continuous time flow by clicking the [Run] buttons. Clicking them 
again, stops the flow. Or use the Time Change Bar to step forward or back by various amounts at a single 
click. 

 
The AstroMapping/Relocate menu choice at the top of the Time/Space Change menu, allows you to 

view an AstroMap for a person. You can relocate charts to new places, and print out maps, here. Read 
Help to learn more. 

 
ix. Hold Chart allows you to store a chart to look at later, e.g. a chart that you created by shifting the 

birth time. These are not kept when you leave the Program! 
 
x. <>Native allows you to see all of the people you have been working with during a session with the 

software, and to quickly switch between them by clicking on their names. The chart replaces whichever 
native has her name in <> brackets, e.g. <Susan>. The <> also indicates that this is the one that will 
change when you click the Time Change buttons described above. You can also apply a native to a single 
chart/table by right-clicking on it and choosing 'Select Native for this'. 

 
xi. Help is very useful. The tutorial, for example, includes videos that play on your screen and can 

help you see how to use the program and text explanations of various topics like Muhurta, Varshphal, 
AstroMapping, Compatibility, etc. The Contents choice shows you the main help sections that you can 
use to learn more about using Shri Jyoti Star. The Index is an alphabetical list of all of the program's 
functions (listed on the left) and where you can find them (listed next to each, on the right). 'Find' lets you 
search for a word throughout the help file. 
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Note: Large charts have something you can click on the far top right. In the graphic above you can 

see ‘< >’. Click on this and you start to see aspect lines in the chart. Each time you click you get a 
different type of aspect. 

 
D. Designing Screens: Start with the Page Wizard to set the layout parameters of the page (under the 
Pages menu). In order to design your own screen, use the Page Down key to move to a screen that is 

empty, and then click on the screen 
where you want to insert a chart, 
table, or graph. The Choices and 
Options menu (which is explained 
in more detail below) will appear, 
and you can select the chart, table, 
or graph that you want. You can 
then repeat the procedure until 
you've filled the page. If you want 
to start over, click on the Pages 
menu at the top and then click on 
Blank Page at the bottom of the 
menu, and the page will be cleared 
of all charts and tables. If you want 
to give the screen a Name (to make 
it easier to find later), you can go to 
the Pages menu and click on 
Name/Rename. 

 
The Page Wizard 

 
The Page Wizard 
 
This let's you set up the page as you 

like and gives you a little preview of how the grid you've chosen will look. The Background and 
Borders button takes you to a screen where you can easily pick a background image from your collection 
and select a border style if desired. Transparent charts let the background image or colour (chosen in 
Global Colours  in the Choices and Options dialog, see below) show through unless you've chose a lotus 
border where that colour pervades the chart. 
 
3. The Printed Page Designer Screen. 
 
You enter the Printed Page Designer Window from the Main Window (button on top right or press F2), 
and use the Printed Page Designer Window to create pages of charts, graphs, and tables to be printed out. 
The reason that the Printed Page Designer exists is because the format of a printed page is different from 
the format of the computer screen.  You can design pages specifically for printing that look better than 
printed screens do. 
 

Important Things to understand about the Printed Page Designer Screen:  
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The Printed Page Designer Screen 

A.. You need to name each Design or set of pages. I am calling the printed pages sets because they can 
be several pages long per set. When you create your own Design or printed page set, you need to name it 
in order to distinguish it from other sets that you design. To create a set, you can either use the default 
"My Design 1" name already provided, or click on the New Design button and create a new set of printed 

pages and give it a name. You can 
change a name you create later, just 
change it and press ‘Enter’ on the 
keyboard. 
 
B. You can switch between sets by 
selecting from the list under 
“Choose/Edit Design Name” and then 
click on the set you want to change or 
print.  
 
C. You design printed pages exactly 
the same way that you design screens 
on the Main Window. You simply 
click on empty parts of the page to pop 
up the Choices and Options screen 
(see below) and select the charts, 
tables, graphs, and dasha lists that you 
want. To switch to the next page in the 
set, you simply click on the ∈ or ∉ to 
the right of the word Page (in the 
center of the screen) or type in the 
number of the page you want. 
 
Of course, you can also use the pre-
designed pages under the Layout 
Examples menu. 

 
Note: for larger lettering in tables, try using a 2x4 format – set this using the Page Wizard. For regular 
size text, 3x5 or 3x6 works well. Drag charts and graphs to the place and size you want. Make sure this is 
ON in the Page Wizard and resize by dragging the rectangle at the bottom right corner of graphs and 
charts. 
 
Using the Choices and Options Screen.  
 
The Choices and Options screen is the place where you will find all of the charts, tables, graphs, and 
dasha listings that you can place on the Main Screen pages or on the Printed Page Designer pages. The 
Choices and Options screen has many different pages: Charts, Tables, Graphs, Dashas, Circle Chart, Birth 
Data/Msg/Pictures, Global Colors, and Global Options. To move to one of these pages, just click on the 
tab at the top of the screen, e.g. click on Dashas to move to the dashas page.  
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A description of each of the Choices and Options pages: 

 
 1. Charts. Here is 
where you can choose many 
different charts. the most 
common choices are in the 
area on the left. In the middle 
are all the divisional charts 
and if you click the Advanced 
Charts tab you get various 
extras such as Ashtakavarga 
charts, varshphal charts, the 
planetarium and much more. 
On the right are all the options 
such as the size of the chart in 
'cells' based on the grid (see 
Page Wizard above), whether 
the chart is Northern, 
Southern, etc. and more. At 
the top of the page you can 
choose a colour scheme, 
transparency and what planets 
and other points you want to 
see in the chart. At the bottom, 

you can pick a chart using a planet as the Ascendant or a blank chart or even a blank space.  
 
Note: You can fix a chart to have a specific sign or planet as the Ascendant/Lagna in North Indian charts 
using the right-click menu once it is on the screen. 
 
 2. Tables. This is one of the most important pages to explore. The most common tables have 
buttons and the rest are under ‘More Tables’. Aspects inter or intra-chart have their own area because of 
all the choices one can make. There are various aspect types, etc. There is also an area with tables for 
compatibility as well as Ashtakavarga. The research area has tables that look at your whole database or a 
subset of it which you select in the Research area on the graphs page. You can’t break anything by 
pressing each button to see what it does, and may discover something you really wanted. A powerful new 
feature is Custom Tables, top right. This lets you choose the columns you want in a table as well as the 
title. Once you've created a table, it can be selected by its title to be placed elsewhere. Transparent tables 
have no border line and the background colour shows through. 
 
 3. Graphs. Virtually all of the numerical values calculated for planets has a graph. Top left is a 
button for the various Muhurta graphs such as you find in some Layout Examples. There is a 
Compatibility area on the right for cross-computations between charts. You can also create Research 
graphs (lower right) showing the distribution of specific factors for everyone in your database. For 
example, if you want to see how many people have the Moon in each of the Nakshatras, you would use 
this feature. Check the "Draw Outline Only" box on the lower right to preserve ink when you print out 
graphs. It may also look nicer. 
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 4. Dashas. On this page, you choose the dasha listings you want to see. The height and width of 
the list is important, because it enables you to see many years of dasas in one list. If you want to see many 
years of dashas in a more compact listing, use the two buttons (labeled Col 2, Lev 2 ...) in the middle. 
Advanced astrologers can explore alternate methods by select a different dasha system, the starting date, 
planet calculated from, cycle length, number of sub-periods (levels) to show, and year length. If you don't 
choose a starting date, the program starts the dasha list at birth. You can adjust the starting position and 
number of levels directly on screen. 
 
 5. Circle Chart. This feature has many advanced functions. It is used to view two different charts 
around the same circle. If you want to see the transiting planets circle a person's natal chart, start with a 
blank page and click on the upper left, and then on the Circle Charts tab, and on this page, select In and 
Out charts (top right), and click on the button under the word Outside (top left) to change it to the chart 
for now, and then click OK (bottom right). If you want to see aspect lines, you can also select them 
(middle right). After creating a Circle Chart, you can then watch the planets move over time by using the 
Run buttons at the top of the screen. (Read both the section 2D viii above and the Help section on the 
Time/Space Change function for more information.) You can have either the inside ascendant or the 
outside one stay fixed at the top (or left) while the other changes with time. 
 
 6. Birth Data/Msg/Pictures. On this page, you can add a message to any page, a line of text like a 
blessing, or insert the birth data for one or both charts. An ideal use of this would be to add a message 
with your name, address, and telephone number to a printed page. You can also put an image in a cell on 
the screen (you can have several on each page). For background images, see Page Wizard above. 
 
 7. Global Colours. By clicking on any of the names of the planets, dignities, etc. the program pops up 
a Color selection window where you can select a new color for it. In the Color selection window, note that 
you can lighten or deepen any color by clicking on it, and then clicking on the Define Custom Colours 
button (at the bottom), and then clicking on the ◄ icon on the right of the screen and while holding your 
mouse button pressed in, pulling the icon up or down.  
 
 On the Global Colours page you can also choose (on the middle right) your Global Colour Scheme 
Preference -- which means whether you want planets shown with a single colour, their natural colours (the 
ones you can choose planet by planet here) or by some scoring scheme. If you choose one of these 
schemes, then you see the items of the scheme and their colours and you can modify them by clicking on 
the item. You can also have colour coding by groups, such as planets, houses, Arudhas, etc. 
 
At the bottom towards the right there is a pulldown entitled ‘Colour Sets for’. This has preset colours for 
both screen use and printing. If you want to keep these two set groups the same and you change the screen 
colours, click the Print=Screen button below. The defaults have White, Yellow, Blue and Parchment 
backgrounds. Note: if at any time something appears to have disappeared, the chances are that its color is 
the same as the background. Resetting the color options from the File menu recovers this or you can guess 
where the item is on the Global Colors page (e.g. Moon is below Sun, above Mars) and click there to 
change its color or simply change the background color, which will reveal the missing items. 
 
 8. Global Options. This page allows you to change the way Shri Jyoti Star calculates charts, 
aspects, strengths, and more. Most people will only use this page for choosing an ayanamsha (the 
difference from a Tropical zodiac -- most astrologers choose Lahiri), the house system used and whether 
the program displays planets as letters or glyphs (top right). Note that the main options are also accessible 
from the File menu by selecting ‘Preferences / Major Options Setup’. Here you can choose complete 
option profiles for popular systems such as Iyer, KP and Systems Approach. 
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AstroMapping 
 

Click the little button with a map on it or choose AstroMapping/Relocate from the Special or 
Time/Space Change menus. Use the buttons at the top to choose the native you want to relocate, Revert to 
the original locations after experimenting, track the charts on screen as you move the Mouse (click Track 
and then hold down the Shift key when you want the charts to change), zoom out, see city names, swap 
the natives and print.  
 

To zoom in, right-click where you want to zoom. Zoom Out with the button at the top. Left-click 
where you want to relocate or type in the city and state/country at the bottom. A little cross indicates the 
place of current location. At the top right, the city closest to the cursor is given. 
 

 
 

Support 
Email support@vedicsoftware.com. I usually reply the same day unless I'm travelling and away 
from a phone, in which case don't panic, you will get a reply. You can also call 1-434-973-2779 (USA 
number). Please don't call initially if you have access to email as this is usually faster. If you need help on 
the phone, then we'll talk. Have fun and let me have any feedback you like to give. If you have queries, 
look in the Q & A section of the Help first as well as the rest of the Help and the Quick Tips depending on 
the query. Also get the latest upgrade as your problem may have been solved! 

 
Experiment and Enjoy! 

mailto:support@vedicsoftware.com
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